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Preface

This is the first book | wrote in 2010 for the KNIME Press on how to use KNIME Analytics
Platform. Since then, we (the KNIME Press Team and I) have been constantly updating the book
twice a year every year, following each new release of KNIE Analytics Platform; not immediately
after — but close enough.

That is right! KNIME Beginner's Luck, like all other e-books from KNIME Press, is a live e-book,
constantly changing to fit the newest version of the software — which is also true for the new
and improved UX/UI that came with KNIME Analytics Platform Version 5 in summer 2023. This
liveness of the e-book is also the reason why it has only rarely been printed. Updating printed
pages is undoubtedly harder than updating a pdf file!

As this is the first book, it is inevitably about the basics: the basics of KNIME Analytics Platform
of course and the basics of a data science project. This book guides you through the most
important access functions, data transformation operations,and of course machine learning
nodes available in KNIME Analytics Platform., Supplemented with many example workflows,
exercises, and screenshots, it will quickly, familiarize you with the basic functions of the
software. If you are looking for more advanceditopics, you won't find them here, instead....

If you want to learn more about advanced machine learning algorithms, flow variables, or loops,
check the sequel to this book:**KNIME Advanced Luck”. If you want to learn more about text
processing, have a look at the book, “Erom Words To Wisdom”. If you come from that school
of thoughts where reading manuals or instructions is overrated, you can start directly with
reading about solutions to ' case studies in various application fields in our
collection “Practicing Data Science”. If your job is more about integrating and blending different
data sources and data types, then the book for you is the “Will they blend?” collection. More
useful booklets are available on the KNIME Press page, if you are transitioning from Excel,
Alteryx, SPSS Modeler, or SAS.

All this is to say that the KNIME Press team and | have been working hard to provide you with
the learning material, books, and tutorials, to become progressively more and more productive
with KNIME Software and data science concepts.

Rosaria Siljpo
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Chapter 1: Introduction

1.1. Purpose and Structure of this Book

We live in the age of data! Every purchase we make is dutifully recorded; every money
transaction is carefully registered; every web click ends up in a web click archive. Nowadays
everything carries an RFID chip and can record data. We have data available like never before.
What can we do with all this data? Can we make some sensefout of it? Can we use it to learn
something useful and profitable? We need a tool, a surgical knifethat can empower us to cut
deeper and deeper into our data, to look at it from many different perspectives, to represent its
underlying structure.

Let's suppose then that we have this huge amount of data<already available, waiting to be
dissected. What are the options for a professional.to enter the world of Business Intelligence
(Bl) and Data Science (DS)? The options‘available are of course multiple and growing rapidly.
If our professional does not control an excessive budget, he or she could turn to the world of
open-source software. Open-source software, however, is more than a money driven choice. In
many cases it represents a software philosophy for resource sharing and control that many
professionals support.

Inside the open-source software world, we can find a few Data Science and Bl tools. KNIME
Analytics Platform ‘representsian easy choice for the non-initiated professional. It does not
require learning a specific script and it offers a Graphical User Interface (GUI) to implement and
document analysis procedures. In addition - and this is not a secondary advantage - KNIME
Analytics Platform can work as an integration platform into which many other Bl and Data
Science tools can be plugged. It is then not only possible but even easy to analyze data with
KNIME Analytics Platform and then to build dashboards on the same processed data with a
different BI tool.

Even though KNIME Analytics Platform is very simple and intuitive to use, any beginner would
profit from an accelerated orientation through all of the nodes, categories, and settings. This
book represents the beginner’s luck, because it is aimed to help any beginner to gear up his/her
learning process. This book is not meant to be an exhaustive guide to the whole KNIME
software. It does not cover implementations under the KNIME Business Hub, which is not open-
source, or topics which are considered advanced. Flow Variables, for example, and
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implementations of database SQL queries are discussed in the sequel book “KNIME Advanced
Luck”.

This book is divided into six chapters. The first chapter covers the basic concepts of KNIME
Analytics Platform, while chapter two takes the reader by the hand into the implementation of
the very first KNIME application. From the third chapter, we start the exploration of data science
concepts in a more in-depth manner. The third chapter indeed explains how to perform some
basic data exploration and visualization, in terms of nodes and processing flow. Chapter four
is dedicated to data modeling. It covers a few demonstrative approaches to machine learning,
Naive Bayes, decision trees, and artificial neural networks. Finally, chapters five, six, and seven
are dedicated to reporting. Usually, the results of an investigation based on data visualization
or, in a later phase, on data modeling must be shown at some point to colleagues, management,
directors, customers, or external workers. Thus, reporting is a very important phase at the end
of the data analysis process. Chapter five shows how to prepare the data to export into a report,
while chapter six shows how to build the report itself.

Each chapter guides the reader through an ETL or'a machiné learning (ML) process step by
step. Each step is explained in detail and, offers some explanations about alternative
employments of the current nodes. At the end of each chapter several exercises are proposed
to the reader to test and perfect what he/she has learned so far.

Examples and exercises in this book haveibeen implemented using KNIME 5.2. They should
also work under subsequent KNIME versions, although there might be slight differences in their
appearance.

1.2. The KNIME Community

Being an open-source software, KNIME Analytics Platform benefits a number of forums and
groups of KNIME users all around the world. This is a good safety net for advice, hints, and
learning material. We report below the most popular sites and groups.

Useful Web Pages

o  KNIME Website: The root page on the KNIME website.

https://www.knime.com



https://www.knime.com/knimepress/advanced-luck
https://www.knime.com/knimepress/advanced-luck
https://en.wikipedia.org/wiki/Extract,_transform,_load
https://www.knime.com/

Chapter 1. Introduction

Software Overview:The first place to look for an overview of all KNIME products. The open
source KNIME Analytics Platform can be downloaded here.

https://www.knime.com/software-overview

Learning Hub: A central spot to access education material to get you started with KNIME.

https://www.knime.com/learning

KNIME Community Hub: The perfect place to search for nodes or example workflows
when you're not quite sure what you need yet.

https://hub.knime.com

KNIME Forum: Come here to engage in community discdssion, submit feature requests,
ask for help, or help others yourself!

https://forum.knime.com

Events and Courses: Information on all our upecoming events including courses, webinars,
learnathons, and summits.

https://www.knime.com/events

Blogs: A collection of blog posts covering data science with KNIME, a great space to learn
what KNIME can really do.

https://www.knime.com/blog

FAQ: A collectionsof:some of our most commonly asked questions, check out the forum
if your answer/isn't here!

https://www.knime.com/faq

KNIME Press. Information on all our available books, like this one!

https://www.knime.com/knimepress

Courses, Events, and Videos

Courses for KNIME Analytic Platform:KNIME periodically offers onsite and online courses
for the KNIME software. This includes basic and advanced elements. To check for the
next available date and to register, just go to the KNIME Events web page
(https://www.knime.com/events) and select the tab “Online Course”.
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KNIME Webinars: A number of webinars are also frequently available on specific topics,
like chemistry nodes, text mining, integration with other analytics tools, automated
machine learning, deep learning, time series analysis, best practices, and so on. To know
about the next scheduled webinars, check the KNIME Events web page
(https://www.knime.com/events) and select the tab “Webinars”.

KNIME Data Connects, KNIME Data Talks, and KNIME Summits: KNIME Data Connects,
KNIME Data Talks and KNIME Summits are held periodically all over the world. These are
always good chances to learn more about the KNIME software, to get inspired about new
data science projects, and to get to know other people from the KNIME Community. To
check for the next upcoming events, just go to the KNIME Events web page
(https://www.knime.com/events) and select the tabs “Data Talks”, “Summit”, or “Data
Connect”.

KNIME TV Channel on YouTube: KNIME has its own video channel on YouTube, named
KNIMETV. There, a number of videos are available to learn more about many different
topics and specially to get updated about the new features in the new KNIME releases
(http://www.youtube.com/user/KNIMETYV).

Books

Advanced Features in KNIME Analyties Platform:

For the advanced'use: Rosaria Silipo & Victor Palacios, “KNIME Advanced Luck”, KNIME
Press

https://www.knime.com/knimepress/advanced-luck
Data Science and KNIME:

For an overview of data science, data mining, and data analytics, please check: Berthold,
M.R., Borgelt, C., Hoppner, F., Klawonn, F., Silipo, R., “Guide to Intelligence Data Science”,
Springer 2020

https://www.datascienceguide.org/

Codeless Deep Learning with KNIME:
It is possible to implement deep learning solutions also within KNIME Analytics Platform:

Kathrin Melcher & Rosaria Silipo, “Codeless Deep Learning with KNIME", Packt, 2020
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e Codeless Time Series Analysis with KNIME.

A book explaining the main steps for time series analysis using the KNIME time series
components.

Corey Weisinger, Maarit Widmann, Daniele Tonini, “Codeless Time Series Analysis with
KNIME", Packt, 2022

KNIME Community Hub

However, there is a privileged place where to find information about KNIME nodes and example
workflows for your next projects: the KNIME Community Hub{(https://hub.knime.com/).

The KNIME Community Hub is a repository of applications, components,and nodes to recycle,
reuse, and assemble on KNIME Analytics Platform. Or as it says on the home page: The KNIME
Community Hub is “the place to find and collaborate on KNIME workflows and nodes. Here you
can find solutions for your data science questions.”

When you access the KNIME CommunityHub thefirst time, you end up with the page in Figure
1.1. This page offers a few links to the starting guide documentation, the KNIME Forum, and

Welcome to the

KNIME.Community Hub

Solutions for data S@lence: indWW@ik{lows, nodes and components, and collaborate in spaces

)\ @®earch workflows, Wlldes and more

4372 1383 226

Components Extensions

KNIME Business Hub

Scale Analytics Across

Getting started

Verified Components

Easily reuse bundled functionalities, verified by
KNIME Experts

KNIME Beginners Space

Examples provided by KNIME

the Enterprise

Learn more about the new release

Figure 1.1. The KNIME Community Hub home page at https.//hub.knime.com.
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the KNIME blog. Most importantly at the top it offers a search box to find applications, nodes,
and components uploaded by KNIME users in this shared place of the KNIME community.

If we type “Customer Intelligence” in the search box, we end up with a list of nodes and
workflows related to Customer Intelligence. If you then select just “Workflows” in the top menu,
you will see a list of applications (workflows) implementing some aspects of Customer
Intelligence - and appropriately tagged - as uploaded by users of the KNIME community. Indeed,
you can upload your own developed applications on the KNIME Community Hub. All you need
is an account with the KNIME Forum.

On the KNIME Community Hub you can also find official dedicated spaces with their own
description and landing page. Try for example to type “Marketing”and select the tag “Marketing
Analytics”. You will get 31 marketing analytics related solutions, hosted in the marketing
analytics space and described on the landing page on the right,.including relevant links.

31 results

All =[5 Workflows Yilten
_— & * Why KNIME for Marketing Analytics
[YEPELEPEERIY [ Ci | [ customer intelligence || Deployment || Sentiment | [ sentimentanalysis | | afiusn
Filter by tag: ‘ H H ” ‘ ce solutions f >al marketing
s such as SEO, customer experience,
workflo,
Price optimization: value- Read relevant blogs
. based pricing and
Slg regression Qe E Machine Learning in Marketing Analytics

E Querying Google Analytics in KNIME

E Sentiment Analysis Tutorial

Worklo This workflowisesdfie’Google Vision API to
Extraction of Image Labelss &kt ct image properties, d
s and Dominant Colors
]

s,and
determine

ord@minance. It then imple. Q1
. Download workflows

magekeolout Jabel S s{  CXand Topic Models

s-{z Google Cloud Vision and Image Features

Workflow

Brand Reputation Tracker

s SEO

]

sl o2
knime
Explore use case
¢” Recommendation Engine for E-Commerce
Marketing Campaigns
o® 1 Find more on KNIME for Marketing Analytics

s

¢ How KNIME powers marketing teams across
industries

Figure 1.2. The list of applications (workflows) related (and tagged) with “Marketing Analytics” on the KNIME
Community Hub.

Clicking one of the applications in the list opens the corresponding page (Figure 1.3), with a
nice explanatory picture of the implemented workflow.
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On the top right corner, you can see the button to log in with your KNIME account. Being logged
in allows you to upload, download, comment, like, and update the spaces and workflows for
which you have permissions. Below that, you can find the author picture and below that a
number of utility buttons: to download the workflow, to like it, to drag & drop it into KNIME
Analytics Platform, and to copy the short permanent link for this workflow to share.

If you hover over the author image, and if you have editing permissions for this Hub space, a
pen will appear. Clicking on it will allow you to give other KNIME users permission to upload
and change this space.

Notice that the KNIME Community Hub is a repository for workflows, but also for nodes,
components, and extensions.

ikNlME Hub ‘ ) Search flows, nodes and more ‘ Pricing  About H signin

KNIME Community Hub > knime > Spaces > Examples > 50_Applications > 24_Customer_Segmentation_Use_Case > 02_Customer_Segmentation_Use_Case

o Workflow
Customer Segmentation

Last edited: Jan 13, 2022 D[g Qs & 7082 ¢ Copy link

| Overview
External resources
Used extensions & nodes
Display Labeled
Clusters e

4 Discussion

Group Loap Start
e

»E
sy crushe
Result |

tering. The nd part of the
ze and label (or write notes) about

the single clusters

Figure 1.3. The page dedicated to the application named “Customer Segmentation” on the KNIME Community Hub,
with short link https.//kni.me/w/37cHxqru6dbliUeP.

1.3. Download and Install KNIME Analytics Platform

There are two available KNIME products:


https://kni.me/w/37cHxqru6dblIUeP
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e the open source KNIME Analytics Platform, which can be downloaded free of charge at
https://www.knime.com/software-overview under the GPL version 3 license

e the KNIME Business Hub, which is described at https://www.knime.com/knime-business-
hub

Analytically speaking, the functionalities of the two products are the same. The KNIME
Business Hub in addition includes a number of useful IT features for team collaboration,
enterprise workflow deployment and management, data warehousing, integration, and
scalability for the data science lab. In this book, however, we will work with KNIME Analytics
Platform (open source). To start playing with KNIME Analytics Platform, first, you need to
download it to your machine.

Download KNIME Analytics Platform

¢ Gotowww.knime.com

e Inthe upper right corner of the main page;click “Download”

e Provide a little information about yourself (that is appreciated), then proceed to step 2
“Download KNIME”

e Choose the version thatssuits yourenvironment (Windows/Mac/Linux, 32 bit/64 bit, with
or without Installer for Windows),optionally including all free extensions

e Accept the terms and conditions

e Start downloading. You will end up with a zipped (*.zip), a self-extracting archive file
(*.exe), or an Installerapplication

e For .zip and .exe files, just unpack it in the destination folder. If you selected the installer
version, just run it and follow the installer instructions.
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-

KNIME  software v Pricing  Solutions v Community Customers  Resources v AboutUs v Q ( Contactus ) ®@

Make sense
of data,

Analyze. Upskill. Scale. No coding required.

" Vatchdemo Download KNIME
N /

KNIME Analytics Platform 5.1 is now available
Explore ng

& new look and improved onboare
Try KNIME's first generati

B INVENTORY e N f . TRUATA! #paloaite

A complete platformi for data science

\ Explore KNIME Softwareh, | Whyopen?

Figure 7.4. The KNIME web page.

1.4. Workspace

To start KNIME Analytics/Platform, open the folder where KNIME has been installed and run
knime.exe (or knime on a Linux/Mac machine). If you have installed KNIME using the Installer,
then you can just click the‘icon on your desktop or on your Windows main menu.

If you are starting KNIME Analytics Platform for the first time, you will be asked if you want to
share your usage statistics with KNIME. These numbers will be used to fuel the best practice
recommendation engine provided within KNIME Analytics Platform workbench: the Workflow
Coach. No personal information will ever reach KNIME and your anonymous statistics will
never be shared with anybody.

After the splash screen, the “Workspace Launcher” window requires you to enter the path of
the workspace.
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The Workspace Launcher

The workspace is a folder where all
preferences and applications  Setecta directory as workspace
KNIME Analytics Platform uses the workspace directory to store its preferences and development artifacts.
(workflows), both developed and
CUI’I’ently under development, are Saved Workspace: | C:\Users\Sanket Joshi\knime-workspace-new Browse...

for the neXt KNIME SeSSIOI‘l [_] Use this as the default and do not ask again
~ Recent Workspaces

The workspace folder can be located  iome o
anywhere on the hard disk. Lounch Concel

By default, the workspace folder is Figure 1.5. The “Workspace Launcher” window.
“..\knime-workspace”. However,

you can easily change that, by changing the path proposed<n the “Workspace Launcher”
window, before starting the KNIME working session,

Once KNIME Analytics Platform has been opened, from withinithe KNIME workbench you can
switch to another workspace folder, by selecting /File” in the top menu and then “Switch
Workspace”. After selecting the new workspace;/KNIME Analytics Platform restarts, showing
the workflow list from the newly selected workspace. Notice that if the workspace folder does
not exist, it will be automatically created.

When having a large number.of customers for example, different workspaces can be used for
each one of them. This keeps eachiworkspace clean and tidy and protects from mixing up
information by mistake:

For this project | used the'workspace “Knime-workspace-new”.

1.5. KNIME Workflow

KNIME Analytics Platform does not work with scripts, it works with graphical workflows.
Small little icons, called nodes, are dedicated each to implement and execute a given task.

A sequence of nodes makes a workflow to process the data to reach the desired result.

10
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What is a Workflow?

A workflow is an analysis flow, i.e., the sequence of analysis steps necessary to reach a given
result. It is the pipeline of the analysis process, something like:

Step 1: Read data
Step 2: Clean data
Step 3: Filter data
Step 4: Train a model

KNIME Analytics Platform implements its workflows graphically. Each step of the data analysis
is implemented and executed through a little box, called node. A sequence of nodes makes a
workflow.

In the KNIME whitepaper' a workflow is defined as follows: "Workflows in KNIME are graphs
connecting nodes, or more formally, direct acyclic gfaphs (DAG).*

X . CSV Reader Columin Filter Row Filter CSV Writer
On the right is an example of a KNIME
. % — > 20 +H
workflow, with: _
OCe (o]o] | (o]e] | (e]e] |

aduli.data file rm column just keep records write to new file
with path relative to "final weight" born outside US with path relative to
“eurrent workflow” "current workflow"

e anode to read data from a file

e anode to exclude some data'columns ]
Figure 1.6. Example of a KNIME Workflow.

e anode to filter out somedata rows

e anode to write the processed datainto a file

Note. A workflow is a data analysis sequence, which in a traditional programming language
would be implemented by a‘series of instructions and calls to functions. KNIME Analytics
Platform implements it 'graphically. This graphical representation is more intuitive to use,
lets you keep an overview of the analysis process, and makes for the documentation as
well.

What is a Node?

A node is the single processing unit of a workflow.

" M. R. Berthold, N. Cebron, F. Dil|, T. R. Gabriel, T. Koetter, T. Meinl, P. Ohl, C. Sieb, and B. Wiswedel, ‘"KNIME: The
Konstanz Information Miner”. KDD 2006 (http.//www.kdd2006.com/docs/KDD06 Demo_13_Knime.pdf).
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A node takes a data set as input, processes it, and makes it available at its output port. The
“processing” action of a node ranges from modeling - like an Artificial Neural Network Learner
node - to data manipulation - like transposing the input data matrix - from graphical tools - like
a scatter plot, to reading/writing operations.

Every node in KNIME has 4 states:

e Inactive and not yet configured  — red light

e Configured but not yet executed — light

e Executed successfully — green light

e Executed with errors — red with cross light
Nodes containing other nodes are
called metanodes or components. File Reader File Reader File'Reader File Reader
On the right are four examples of the (3> (3 » (3 » (3>
same node (a File Reader node) in opd o Yo o0e ogo

each one of the four states.
Figure 1.7. The File Reader node in different states.

1.6. File Extensions:
.knwfand .knar

KNIME workflows can be packaged and exported in .knwfor .knar files. A .knwffile contains
only one workflow, while a .knar file contains a group of workflows. Such extensions are
associated with KNIME Analytics Platform. A double-click opens the workflow inside KNIME
Analytics Platform.

01_From_Strings_to_Documents knwf 10/4/2 KMNIME Workflow ... 18,619 KB
04_Interaction_Graph. krnwf G/29/ KMIME Workflow ... 9,465 KB
0&_REST_Examples_Google_Geocodeknwf 7 KMIME Workflow ... 62 KB
06_Sernantic_Web_updated.knar 1143/ KMIME Archive File 178 KB
AzureDemoWorkflowArchive.knar 5/3/2017 11:24 AM KMIME Archive File 24104 KB
Building a Simple Classifier_knwf 2/18/2017 KNIME Workflow ... 43 KB
Cookbook_Ch3.knar 11 v KMNIME Archive File AT7T KB
Cookbook_Ché.knar 11/24/2017 10:26...  KNIME Archive File 135 KB
Corsair.knwf 7/10/2017 4:20 PM KNIME Workflow ... 106 KB

Figure 1.8. .knwf and .knar files are associated with KNIME Analytics Platform. A double-
click opens the workflow(s) directly inside the platform.
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1.7. KNIME User Interface

After accepting the workspace path, the KNIME Ul opens on a “Getting started with KNIME
Analytics Platform 5” entry page. This page provides access to the local space or create a new
workflow. This page also provides the mount points. You can connect to them for usage by
clicking the sign-in button. The “KNIME User Interface” consists of a top menu, a tool bar, and
a few panels. Panels can be closed, re-opened.

Home button: This panel shows the list of workflow projects available in the selected
workspace (LOCAL), on the EXAMPLES, on the My-KNIME-Hub (your own space on the
KNIME Community Hub), or on other connected KNIME Hub spaces.

Quick node adding panel: This is a node recommendation engine. It will provide the list
of the compatible nodes to follow the currently selected‘node. You will also be able to
search for the other available nodes by typing intkeywords inthe search field. Double-click
the node you want to add to the workflow, and it will be added and connected
automatically.

Node Repository: This panel contains all the nodes that are available in your KNIME
installation. It is something similar to a palette of tools when working in a report or with a
web designer software. Théere we. use graphical tools, while in KNIME we use data
analytics tools.

e | My First Workflow
Node
. e Workflow Editor
Repositorv -
2
)
Space Explorer o
Quick node
3 B adding panel

Node Monitor

Figure 1.9. The KNIME user Interface.
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o  Workflow Editor: Workflow Editor is the central part of the KNIME Ul. A node can be
selected from the “Node Repository” panel and dragged and dropped here, in the
“Workflow Editor” panel. Nodes can be connected by clicking the output port of one node
and releasing the mouse either at the input port of the next node or at the next node itself.

e Space Explorer: To navigate to local or KNIME Hub spaces and access the workflows,
components, and files, you can switch to the “Space Explorer” panel.

e  Node Description:|f a node or a workflow is selected, the “Node Description” panel on the
left displays a summary description of the node’s functionalities or the workflow’s meta

information.

1.8. Help

(® Help {5} Preferences Menu
. . QY i ce od guide
The “Help” button is one of the newer options added to the NET—
KNIME User Interface in version 5.2. y N KNMEL &

It includes a few more buttons; if yousclick,on those
buttons, you will be redirected to the respective website.

Figure 1.70. The "Help"button in KNIME.

1.9. Preferences

A - il

@lm rE

&0

My First Workflow

I
a
L3
¥
[

Figure 1.71. The “Preferences” option in the KNIME User Interface.

Preferences brings you to the window where all KNIME settings can be customized. Under the
item “KNIME” can be found:

e Chemistry — has settings related to the KNIME Renderers in the chemistry packages.
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Databases — specifies the location of specific database drivers, not already available
within KNIME. Indeed, the most common and most recent database drivers are already
available in the driver menu of Database nodes. However, if you need some specific driver
file, you can set its path here.

Space Explorer — contains the list of the shared repositories via KNIME Hub spaces.

KNIME GUI - allows the customization of the KNIME workbench options and layout via a
number of settings.

Master Key — contains the master key to be used in nodes with an encryption option, like
database connection nodes. Since KNIME 2.3 database passwords are passed via the
“Credentials” workflow variables and the Master Key préference has been deprecated.
You can still find it in the Preferences menu for backward compatibility.

In Meta Info Preferences you can upload meta-info template for'nodes and workflows.

Here you can also find the preference settings for the external packages, like H20, R,
Report Designer, Perl, Perl, Open Street Map, and othérs if you have them installed. In
particular, for the external scripts, this page offers the option to set the path to the
reference script installation.

Finally, Workflow Coach contains.the ‘dataset to be used for the node recommendation
engine: the community, a Hub workspace, or your own local workspace.
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w General
v Appearance
Colors and Fonts
Keys
> Metwork Connectien:
> Security
> Startup and Shutdow
Web Browser
> Workspace
w Install/Update
Automatic Updates
Available Software Sit
Trust
v KNIME
Customization Profile
Databases
JavaScript Views
KNIME Explorer
KNIME Medern Ul
~ KNIME classic user in
Workflow Editor
Kerberes
Master Key
Molecule Sketcher
Preferred Renderers
Report Designer
v Table Backend
Columnar Backen:
Row-based Backer
v Workflow Ceach
Server Recommen
Workspace Recorr
+ Report Design

Rirlirartinmsl Drnnarti

Tool Bar

Workflow Editor

[ Set node label prefix

Font size of node name and label:

Chapter 1. Introduction

Node

These grid preferences apply to new warkflows only.

[ Show giid
18 Snap to grid
Horizntal grid size (in px):

Vertical grid size (in px):

20

20

To change the grid settings of a workflow, use the
"Workflow Editor Settings' toolbar button.

These nede connection settings apply to new workflows only.

8 Curved connections

Node connections line width:

To change the nede connection settings of a workflow, use the
'Workflow Editor Settings’ toalbar button.

Comma delimited list of zoom values:

10, 25, 33, 50, 67, 75, 90, 100, 110, 125, 150, 175, 200,250

Zoom level change when the CTRL+ALT keys are held down:

5

18 Highlight the inport and outport connection lines of a selected node.

The color to use in highlighting connection lines:

The coler te use in highlighting the flow variable connection lines: [N

The change in width when highlighting connection lines:

1

Figure.1.72. The “Preferences” window.

The tool bar is anotﬁer important piece of the KNIME User Interface.

v

77 Reset

Create metanode

& Create component

Figure 1.13. The "Create Metanode” button in the tool bar.

From the left, we see

Restore Defaults

Apply and Close

Apply

Cancel

100% v

e anicon to save or save as the current workflow. To the left, we find the icon to save the
selected workflow

e undoand redothe changes that were made to the workflow

e execute or execute all (which executes all the selected nodes)

e cancel/the executing node(s)

e resetall the node(s) to the original state

e create Metanode
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e create Component,

e the arrow icon which provides the option of selecting, using the annotating mode or using
the panning mode

e and on the right is the zoom (in %) level selection.

For now, let's have a look at the Create Metanode button. The Create Metanode button creates
a metanode for all the selected nodes. It creates one node inside which you can find all the
selected nodes. This is particularly useful to create a clean and easy-to-use workflow, for
example, by compressing all the nodes used for data cleaning within a Pre-processing
metanode.

Hotkeys

For all keyboard lovers, most KNIME commands can alse run viashotkeys. All hotkeys are listed
in the KNIME menus on the side of the corresponding commands or in the tooltip messages of
the icons in the Tool Bar under the Top Menu: Here are the most frequently used hotkeys.

Node Configuration

e F6 opens the configuration window of.the selected node

Node Execution

e F7 executes selected configured nodes

e Shift + F7 executes all configured nodes
Stop Node Execution

e F9 cancels selected running nodes

e Shift + F9 cancels all running nodes

Node Resetting

e [F8resets selected nodes

Save Workflows
e Ctrl + S savesthe workflow

e Ctrl + Shift + S saves all open workflows
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e cCtrl + wcloses all open workflows

Metanode

e Shift + F12 opens Meta Node Wizard

To move Annotations

e Ctrl + Shift + PgUp/PgDown moves the selected annotation in the front or in the
back of all the overlapping annotations

1.10. Menu

(@) Help {5 Preferences

The “Menu” option button is another option added to the
KNIME User Interface in KNIME Analytics Platform v5:2.

Once you click this button, you will see multiple options, @ Insta
and we will see what each option does.

e  Check for Updates: On clicking this option, you can
see if any updates are available for. your KNIME
Analytics Platform.

o Show KNIME log in File Explorer: This option will

open a window inyour local §ystem where the KNIME ~ 779u7e 7-14. The “Menu"button in the tool

o bar.
log file is stored.

e Install Extensions: On clicking this option, you will be able to see a list of extensions that
you could install.

o Switch Workspace: This will allow you to change the working directory.

e Switch to Classic User Interface: This option will first ask you to save or not save the
current workflow and then switch to the classic Ul. You can also switch back to the
Modern Ul from the classic Ul by clicking on the “Open KNIME Modern Ul” option in the
top right corner of the Analytics Platform.
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1.11. Node Repository

In the lower left corner, we find the Node Repository,

containing all installed nodes organized in categories and pository » Results

subcategories. KNIME  Analytics Platform  has exce

accumulated by now more than 1500 nodes. It has

become hard to remember the location of each node in the Excel Reader Excel Writer  Excel Cell Updater
Node Repository. To solve this problem, two search B -i& S
options are available: by exact match and by fuzzy match, e e

both in the search box placed at the top of the Node > -

Repository panel.
Figure'1.15. Word search in the Node

Reépositorypanel: exact match mode.

Search Box

At the top of the “Node Repository” panel there is a search.box. If you type a keyword in the
search box and hit “Enter”, you obtain the list. offnodes containing an exact match of that
keyword. Press the “Esc” key to see all nodes again.

1.12. Space Explorer

We find the Space Explorer panel below the Home button, one of the four panels on the
KNIME User Interface. Thisjpanel contains:

e Under LOCAL the workflows that have been developed in the selected workspace
e The mount points to a number of KNIME Hub spaces.
e The workflows contained in the reference workspace of such Hub spaces.

e The access to the My-KNIME-Hub, that is to your space on the KNIME Community Hub.
Remember that you need an account with the KNIME Forum to access this space.

At the beginning, the Space Explorer panel only contains LOCAL, My-KNIME-Hub, and
EXAMPLES. As we already stated, LOCAL shows the content of the selected workspace.
EXAMPLES points to a read-only public repository, accessible via anonymous login. This
repository hosts a number of example workflows that you can use to jump start a new project.
My-KNIME-Hub allows to access your space on the KNIME Community Hub.
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When you open KNIME Analytics Platform for the first time, you will find a folder named
“Example Workflows” containing the solutions to a few common data science use cases,

comprehensive of data.

Folders in “Space Explorer”, containing workflows, are also called “Workflow Groups”.

Note. Space Explorer panel can also host data. Just create a folder under the workspace
folder, fill it with data files on the machine, and select “Refresh” in the context-menu (right-

click) of the “Space Explorer” panel.

My-KNIME-Hub

From the Space Explorer panel, you can access your
spaces on the KNIME Community Hub and upload and
update new or existing content in there.

By default, an authenticated KNIME user has a public
space, for material to share publicly, andta private space
to park his/her own material for further usage. However,
new private or public spaces can beicreated with a right-
click on My-KNIME-Hub in the Space Explorer panel and
then a selection of the option “Create new:Space...".

By default, you are thesonly owner of your own spaces.
However, when accessing.this space from a web browser,
after hovering on youriimage in the top right corner, a pen
appears. This will allows“us to add colleagues and
teammates as contributors to the space.

EXAMPLES

hub (-
Ewangelism - Certification

alinebessa — Just KNIME It! Season 2
emilio_s — L1-ALL update 2023

roberto_cadili — Workflow Tournament 2023
sanket_2012 - Private

sanket_2012 - Public
Signin

Signin

Figure 1.16. Space Explorer panel. At the
top the content of the EXAMPLES;, below
the content of the LOCAL workspace.

A link to EXAMPLES is available in the “Space Explorer” panel. This is a repository provided by

KNIME to all users for tutorials and demos. There you can find a number of useful examples
on how to implement specific tasks with KNIME. To connect to the EXAMPLES:

e double click "EXAMPLES" in the “Space Explorer” panel

e double click “Double click to connect...”
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You should be automatically logged in as a guest.

To transfer example workflows from the EXAMPLES to
your LOCAL workspace, just drag and drop or copy and
paste (Ctrl-C, Ctrl-V in Windows) them from “EXAMPLES”
to “LOCAL".

You can also open the EXAMPLES workflows in the
workflow editor, however only temporarily and in read-only
mode. A yellow warning box on top warns that this Figure 1.17. Space Explorer panel.
workflow copy will not be saved.

| EIEIEAEL
v

The Space Explorer panel can of course host more than one KNIME Hub space. It is enough to
add mountpoints to the list of the available KNIME Hub spaces.

Mounting KNIME Business Hub in Space Explorer

To add KNIME Business Hubs to the “Space Explorer” panel, in the modern Ul, click on
“Preferences” -> KNIME -> KNIME Explorer and:

e The “Preferences (Filtered)” window opens, on the “KNIME Explorer” page and lists all
KNIME spaces already mounted inuthis KNIME instance. The three KNIME spaces
available by default on every.KNIME instance are the local workspace “LOCAL", the KNIME
“EXAMPLES”, and the' MysKNIME-Hub located on the KNIME Community Hub
(hub.knime.com).

e Use the “New™ and the “Remove” button to add /remove connections to remote Hub
spaces.

e After clicking the “New” button, fill in the required information about the KNIME Business
Hub in the “Select New Content” window (Figure 1.18).
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Preferences (Filtered) O
type filter text X KNIME Explorer e - 8

v KNIME Set up mount peints for usage in KNIME Explorer view. In KNIME Maedern Ul only mount points of type "KNIME Hub" are
KNIME Explorer shown in the explorer,

List of configured mount points:

MountlD Mounted Content Mounted Type Mew

B ditohuo 4 oomemste—— 2 KNMEH

B imedev-busin.. £ (IS¢ KNIME Hub .

B imecdhi 4 O 4 KNIME Hub Remore
B  Instumentation 4~ E — A= KNIME ServerSpace

B MKNMEHD L CEE——) ¢ KNIME Community Hub Up

B oowpes A O KNMEBemplesener |

® ocal #4 Local Workspace 4 Local Workspace B
Link components when sharing on Server or Local Workspace  Prompt v

B Show a waming dialog when connecting to a server via EJB

B Show a waming dialog when connecting to an older server

Restore Defaults Apply

Apply and Close Cancel

Figure 1.18. The/Preferences (Filtered)” window.

The same KNIME Explorer “Preferences” page.can be reached
via File > Preferences > KNIME EXp/O/' er. Mounting a new resource for display in the KNIME Explorer

Pleas source that should be mounted

n.

To login into any of the available KNIME,Business Hubs in the
“Space Explorer” panel:

£ KNIME ServerSpace

e right-click or double-click the Hub space name oo

e provide the credentials

Server sddress: hitpi//localhest:8060

Authentication type:

Workflow Editor

Enter the name of the Maunt 10,

Mount ID:

The central piece of the KNIME User Interface consists of the
workflow editor itself. This is the place where a workflow is built o e
by adding one node after the other. Nodes are inserted in the Figure 1.19. The “Select New
workflow editor by drag and drop or double-click from the Node Content” window.
Repository or the Quick node adding panel. The workflow

building process will be described widely in the next sections of this book. Here, we will
describe how to customize and probably improve the canvas role of the workflow editor space.
We will describe two options:
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e change the canvas appearance with grids and different visualizations for the connections;

e introducing annotations to comment the work.

Adding annotations to the canvas

It is also possible to include annotations in the workflow editor. Annotations can help to explain
the task of the workflow and the function of each node or group of nodes. The result is an
improved documentation-like overview of the workflow general task and of the single sub-

tasks.
Normal text B I U gz i= e = =

This is‘an annotation

Workflow Annotations

To insert a new annotation: .. ;
This is an.annotation

e right-click anywhere in the workflow editor

and select “New Workflow Annotation” Hisisarerataton

e agray small frame appears; this is the default
annotation frame

Figure 1.20. The Annotation Editor.
e double-click the frame to editiitsicontent
¢ Notice the tool bar appearing at the top to edit text style, text size, background color, text
alignment, and border properties;(color, thickness)

e Toreopen an annotation, just double-click anywhere on the annotation

1.13. Download'the KNIME Extensions

KNIME Analytics Platform is an open-source product. As every open-source product, it benefits
from the feedback and the functionalities that the community develops. A number of
extensions are available for KNIME Analytics Platform. If you have downloaded and installed
KNIME Analytics Platform including all its free extensions, you will see the corresponding
categories in the Node Repository panel, such as KNIME Labs, Text Processing, R Integration,
and many others. However, if at installation time, you have chosen to install the bare KNIME
Analytics Platform without the free extensions, you might need to install them separately at
some point on a running instance.
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Installing KNIME Extensions

To install a new KNIME extension from within KNIME Analytics Platform, there are three
options.

1. From the Top right options, select Menu - “Install KNIME Extensions”, select the desired
extension, click the “Next” button and follow the wizard instructions.

2. IF you want install extension from the classic Ul, From the Top Menu, select “Help” i
“Install New Software”. In the “Available Software” window, in the “Work with” textbox,
select the URL with the KNIME update site (usually named “KNIME Analytics Platform 5.x
Update Site” - http://update.knime.com/analytics-platform/4.x). Then
select the extension, click the “Next” button and followthe wizard instructions.

3. Search the KNIME Community Hub, on a web browser or from the’ KNIME Community Hub
panel. When the desired extension is found, drag and drop the extension icon from the
browser to the Workflow Editor.

x
Available Software.
shto st =

KNIME  Hub

d mre satware by merking it the e o5 prefmences. KNIMEHub > knime > Extensions > KNIME DeepLearning - Keras Integration

KNIME Deep Learning - Keras Integration ¥
| Drag and drop to
Workflow Editor ( = ,
for installation

This feature contains nodes of the Keras integration of KNIME Deep
Salect a0 Daselect AN Leaming

Figure 1.21. The “AvailableSoftware” window. Figure 1.22. An extension from the KNIME
Community Hub.
Once the selected KNIME extension(s) has/have been installed and KNIME has been restarted,

you should see the new category, corresponding to the installed extension, in the “Node
Repository”.

In the “Available Software” window you can find some extension groups: KNIME & Extensions,
KNIME Labs Extensions, KNIME Node Development Tools, Sources, and more. “KNIME &
Extensions” contains all extensions provided for the current release; “"KNIME Labs Extensions”
contains a number of extensions ready to use, but not yet of x.1 release quality; “KNIME Node
Development Tools” contains packages with some useful tools for Java programmers to
develop nodes; “Sources” contains the KNIME source code. Specific packages donated by third
parties or community entities might also be available in the list of extensions. These are usually
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grouped under “Community” categories. My advice is to install all extensions, even the
cheminformatics ones. Many of them contain several useful nodes not necessarily restricted
to a particular domain.

1.14. Data and Workflows for this Book

This book builds a few examples and provides the solutions to the exercises. The workflows
are accessible via the KNIME Community Hub and are stored in the KNIME Press space — look
for the respective book and KNIME version. To download material from the KNIME Community
Hub, you need to be logged in with your KNIME account (see hoWw to create a KNIME account).
After entering the KNIME Community Hub, in order to download theworkflows, just click on the

cloud icon. Download the whole folder onto your machine from the KNIME Beginner’'s Luck
space, which will result in a .knarfile. Then double click it OR impertit into the KNIME Explorer
via Select “File” > “Import KNIME Workflow...".

pen forlnovation o
KNIME Hub | ea f es a e Pricing  About : &
KNIME Community Hub > knime > Spaces > KNIME Press > KNIME Beginner's Luck
@ Public space
(718
KNIME Press @\
o ) ( ¢ copylink
Home > KNIME Beginner's Luck P’
«

KNIME Beginner's Luck v5.2 - Exercises (o)

Figure 1.23. Beginners Luck space on the KNIME Community Hub.

At the end of the import operation, in the Space Explorer panel you should find a AN/IME
Beginner’s Luck v5.2 - Exercises folder containing Chapter2, Chapter3, Chapter4, Chapter5,
Chapter6, and Chapter7 subfolders, each one with workflows and exercises to be implemented
in the next chapters. You should also find a KBLdata folder containing the required data.

The data used for the exercises and for the demonstrative workflows of this book were either
generated by the author or downloaded from the UCI Machine Learning Repository, a public
data repository (http://archive.ics.uci.edu/ml/datasets). If the data set belongs to the UCI

Repository, a full link is provided here for download. Data generated by the author, that is not
public data, are located in the KBLdata folder.
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Data from the UCI Machine Learning Repository:

e Adqult data: http://archive.ics.uci.edu/ml/datasets/Adult

e /ris data: http://archive.ics.uci.edu/ml/datasets/Iris

o Yellow-small.data (Balloons): http://archive.ics.uci.edu/ml/datasets/Balloons

e Wine data: http://archive.ics.uci.edu/ml/datasets/Wine

1.15. Exercises

Exercise 1

Create your own workspace and name it “book_workspace”. Youwill use this workspace for
the next workflows and exercises.

Solution to Exercise 1

e © KNIME Analytics Platform Launcher

e Launch KNIME

Select a directory as workspace

KNIME Analytics Platform uses the workspace directory to store its preferences and development artifacts.

e In Workspace Launcher window,
click “Browse”

Workspace: | /Users/knime/knime_4.3.0/book_workspace ) Browse
Use this as the default and do not ask again

° Select the path for your new » Recent Workspaces

ancel unch
workspace ) e

C " Figure 1.24. Exercise 1. Create workspace ‘book_workspace”.
e Click “Launch g P P

To keep this as your default workspace, enable the option on the lower left corner.

Exercise 2

Install the following extensions:
e KNIME Database
o KNIME Javascript Views
o KNIME Report Designer
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Solution to Exercise 2

From the Top right corner options, select Menu - “Install Extensions”. Search and select the
required Extensions. Click “Next” and follow the instructions.

Available Software Available Software
Select All report x Select All
. KNIME Big. - N 4+ KNIME Report Designer (BIRT) 5.2.0.v202311161028
- Biformatics 8GS . KNIME Reparting s20u01182225
KNIME Commus xtensions - Cheminformatics ~ KNIME Community Extensions - Other
()00 KNIME Cor e Processing and Analysi 1- Continental Nodes for KNIME 14.1.v202305230618
O KNIME Hub & S x
KNIME Partner Extensions
Details Details
Hide iterrs that are slready installed 8 5how only the latest versions of avalibig SRt ware Hide items that are already instalied
What s already installed? BGroip items by category What s e,
Show only software apphcable to target environment Snow Bl software applicable to target envirbgMent
Figure 1.25. Exercise 2: List of KNIME Extensions. Figure 1.26. Exercise 2: Reporting Extension.

Exercise 3

Search all “Row Filter*’nodes in the Node Repository. From the “Node Description” panel, can
you explain what the difference is between a “Row Filter”, a “Reference Row Filter’, and a
“Nominal Value Row Filter"? Show the node effects by using the following data tables:

Original Table Reference Table

Position | Name Team Ranking | Scores

1 The Black Rose 1 22

Cynthia 3 14

Mother

Augusta

4
4
Tinkerbell 4 4 10
4
3
3

| o] | W N

The Seven Seas
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Solution to Exercise 3

Row Filter

The node allows for row filtering according to certain criteria. It can include or exclude certain
ranges (by row number), rows with a certain row ID, and rows with a certain value in a selectable
column (attribute). In the example below, we used the following filter criterion: team > 3

Original Table Filtered Table
Position | Name Team Position | Name Team
1 The Black Rose 4 1 The Black Rose 4
2 Cynthia 4 2 Cynthia 4
3 Tinkerbell 4 3 Tinkerbell 4
4 Mother 4 4 Mother 4
5 Augusta 3
6 The Seven Seas 8 q

Reference Row Filter

This node has two input tables."The firstinput table, connected to the bottom port, is taken as
the reference table; the second inpat table, connected to the top port, is the table to be filtered.
You have to choose the reference column in the reference table and the filtering column in the
second table. All rows with a wvalue in the filtering column that also exists in the reference
column are kept, if the option“include” is selected; they are removed if the option “exclude” is
selected.

Reference Table Filtering Table
Ranking | Scores Position | Name Team
1 22 1 The Black Rose 4
3 14 2 Cynthia 4
4 10 3 Tinkerbell 4
4 Mother 4
5 Augusta 3
6 The Seven Seas 3
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Resulting Table

Position | Name Team
1 The Black Rose 4
3 Tinkerbell 4
4 Mother 4

In the example above, we use “Ranking” as the reference column in the reference table and
“Position” as the filtering column in the filtering table. We have chosen to include the common
rows.

Nominal Value Row Filter

Filters the rows based on the selected value of a nominal attribute. A neminal column and one
or more nominal values of this attribute can be selected as the filter criterion. Rows that have
these nominal values in the selected column are.included in the output data. Basically, it is a
Row Filter applied to a column with nominal values.Nominal‘columns are string columns and
nominal values are the values in it.

In the example below, we use “name” as the nominal column and name = Cynthia as the
filtering criterion.

Original Table Filtered Table

Position Name Position Name Team

1 The Black Rose 2 Cynthia 4

Cynthia

Tinkerbell

Mother

Augusta

ol g | WO N
Wl W | D] B Ps

The Seven Seas
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